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Outline

» Boiler Interiors: Slagging and Pollutant Formation
» Mid-IR Imaging and Slag Index

» Slag Index at Duke Energy
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Reduce Slagging/Pollutant Formation

= Load Cycling/Fuel Switching is a Key Driver

Data Used to Minimize ’

Emissions and Improve
Efficiency
Mid-IR Image ®
Machine Vision
Measures
Slagging Here

Acoustic Pyrometers Generate
Temperatures Maps Here

Temperature Ma
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Volatile Matter
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Ash Deposition is a Key Problem

» Issues
» Heat Transfer Degradation: Lower Efficiencies
» Costs of Removal
» Shutdowns and Maintenance Problems

» Molten Particles are Retained whereas Much of
the Dry Ash Rebounds and is Re-entrained in the
Flue Gas
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Ash Fusion Temperatures

» Ash Fusibility Test (Ash Fusion Temperature)
» Stages of Softening and Flow

» Ash Viscosity Test

» Ash Chemistry (puzy, 1965)
» (Fe,0;+Ca0+Mg0O+K,0+Na,0)x5/(S10,+Al,05+Ti0O,)
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Index Limitations

» Ash Fusion Test Temperatures
» Weak Reproducibility, Variability up to 360 F
» Ash Samples Reacted at Temps < Initial Deformation Temperature

» Viscosity Measurements

» Ashes Sticky at Temperatures below Temperatures at Which
Viscosity Can Be Measured

» Uncertainties Up to +/- 50%

» Ash Chemistry
» Fails if Most of Iron is in Form of Siderite vs Pyrite
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Thermal NOx

» Extended Zeldovich Mechanism
»N, +O — NO +N
»N+0,>NO+O
»N+OH—->NO+H

» Exponentially Fast at High Temp (T> 2900F)
when Oxygen Present
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Sulfur in Coal

» Sulfur Generally Occurs in Four Forms
» Pyritic Sulfur (Included and Excluded)
» Sulfate Sulfur
» Organic Sulfur
» Free Sulfur
» Pyritic Sulfur (FeS,) is Often the Most Important:

» Influences Slagging
» E.g., Multiplicative in Duzy Ash Chemistry Index

» Influences Acid Gas Formation
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Pyrite Oxidation

FeS, — (1-x) Fey.S + (1-x) 5

Fe.S + (1+x/2) O, — (1-x) FeO + SO
Fe.9S + (1-x) SO — (1-x) FeO + (1-x/2)s,
Fe.xS + (1-x) O — (1-x) FeO +5

FeS, + O, — FeS + 50,

FeS, + SO — FeS + S, + O

FeS + O, — FeO + SO

FeS + SO — FeO + S,

FeS + O — FeO + S

2FeO + 02 — Fe,0, + O

FeO + Fe,0; — Fe;0,

vV v v v vV Vv Vv VvVvYvVvyYVvyy

Feb 2018




SO, Production Effects
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Coal Parameter Variability




Operating Considerations

» Coal Composition

» Coal Particle Size

» Air Distribution

» Burner Operation

» Excess Air Level

» Flame Impingement
» Sootblower Operation
» Boiler Load
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» Slag Index at Duke Energy
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Why Mid-Infrared Imaging?

» Main Visible Image Obscuration is due to Particle Scattering
» Particle Scattering Decreases as Wavelength Increases
» ~ 1/A\* Rayleigh Scattering

UV is less than IR is greater
400 nm than 800 nm

— —

So viewing with longer wavelengths is desirable?
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Viewing Windows

There are only certain windows available though!

l||
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Mid-IR Boiler Inspection Cameras

Imaging Core

Mobile Fixed Mount
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Mid-IR View of Upper Furnace




Data Flow 1: Direct Video to Operator

Models Archive Computer Controllers (DCS)

Mid-IR Sensors ‘ Actuator

The Process
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Where Does Slag Index Fit In?

» Provides a tangible metric that does not require
human interpretation.

» Expands use of IR Imaging technology towards
automated interpretation and closed-loop
control
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Slag Index Software Dashboard




Data Flow 2: Interpretive Software to DCS

Models Archive Computer Controllers (DCS)

Slag Index

Interpretive Software
Mid-IR Sensors ‘ Actuator

The Process
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Time-lapse Report Example




Utilization?

So, now that we have this tool,
what can we do with it?
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Duke Energy IR Camera Applications

«  Currently have 20 IR cameras (12 permanent installations and 8 portables) across
the fleet

e  (Cameras are used for,

«  Monitoring units for slag/clinker build-up that could result in a clinker fall & slope
tube damage

»  Chemical dosing optimization

«  Better understand the operational “triggers” that lead to slagging
«  Sootblowing effectiveness

«  (Coal blend slagging propensity

*  Aninstrument supplying the numerical quantity of ash build-up in the furnace,
independent of Operator perception.
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IR Cameras, the Outputs

* IR cameras supply continuous visual and quantitative data.

« Using up to 4 zones for each camera, the known areas in the furnace that slag can
be more thoroughly monitored for ash build-up increases.

«  The camera software produces reports for the previous days operation. The
“Timelapse Report” combines the slag index trend with a 2.5 minute video.

« Like any measurement, yesterdays data is something we should learn from, but we
need to use this instrument/data to affect the outcome of todays operations.

RC_Timelapse Report 4-18-2017.avi.mp4 RC_Timelapse Report 5-16-2017.avi.mp4
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Slag Index Software Dashboard
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IR Camera Outputs — Using this tool to Help Current Op’s

= The best way we have found to use this Slag Index software is to have the operator
monitor the Sl software dashboard , noting the S| value trends as the shift progresses.
If the sootblowers are not effective, the Sl values climbing, then other proactive steps
need to be taken to insure unit reliability such as,

= |oad reduction to shed,

Substitution of mills in-service to affect FEGT'’s

slag mitigation chemical dose rate change,

= more aggressive sootblowing cycles,

= investigate sootblower air/steam supply pressures/lance nozzle condition,
fuel change to give the unit a chance to recover
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Slag Index Data — From Daily Reports — yesterdays NEWS

= Zone Specific Sootblower Effectiveness,

= |f there is no reduction in Sl value when the sootblowers are actuated (ie no slag/ash
removed), then we are wasting compressed air or steam and wearing out the sootblowers
and boiler tubes. This is a quantification of the bond strength between the boiler tubes and
the ash, and between ash to ash.

= Zone Specific Average Sl values

= |s there more or less build-up in the yesterday vs the day before? A bulk understanding of
this can be determined by taking the average of all the Sl values each day

= Zone based trends in Sl value

= |s the Sl value higher at the end of the day than the beginning? This can be misleading.
Example,

= At 00:01 the Sl value for a particular zone was 10, and the sootblowers in that area had just cycled, compared to
23:59, the Sl value was 20 and the sootblowers had not cycled since 21:00. If the increase in Sl from 21:00 till
23:59 was significant, this metric could be misleading.
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Daily Sl Trending

* Isit ash build-up if a sootblowing cycle removes it?

Sootblower Effectiveness

\ /

Min value = 10

Min value = 12
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Operational “Triggers” for Slagging

Predictive Slagging Metrics Operations Slagging Metrics
Predicted SH %age of day > 645 %age of day <2.5% %age of day FEGT > Nun'.\ber of R Combined Daily Operational
Predicted Slagging Predicted Ash Actual Left Side Right Side MW's Backpass 02 2150°F Sootblowing Cycles in Ash Loading in Index (Green=0,
Date HH Index Potential Fusion Temp Max FEGT| SB's OOS SB's OOS the day Lbs/MMBtu Yellow=1,Red=2)

4/8/2017 1.24 (1.65) 2205 2157 15 16,28 54% 4.5% 1.39% 8 4

4/9/2017 1.19 (1.63) 2228 2156 15 16,28 30% — 1.04% 7 6
4/10/2017 1.00 (1.72) 2255 2139 15 16,28 11% 3.1% 0.00% 8 7.03 1
4/11/2017 1.05 (1.68) 2242 2157 15 16,28 36% 9.4% 3.13% 8 7.15 2
4/12/2017 1.05 1.46 2166 2158 15 16,28 31% 2.78% 8 6.90 2
4/13/2017 ] 15 16,28 21% 10.07% 8 7.26
4/14/2017 1.25 (1.65) 2203 2169 15 16,28 15% 3.8% 5.56% 8 3
4/15/2017 1.19 (1.65) 2219 2074 15 16,28 0% 0.0% 0.00% 8 2
4/16/2017 (1.68) 2165 2000 15 16,28 0% 0.0% 0.00% 7 5
4/17/2017 1.25 (1.65) 2201 2145 15,27 16,28 18% 7.3% 0.00% 8 5
4/18/2017 1.20 (1.65) 2216 2153 15 16,28 50% 0.35% 8 5
4/19/2017 1.12 (1.64) 2240 2168 15 16,28 49% 16.67% 7 7.27 7
4/20/2017 1.00 d 2320 2167 15 16,28 55% 15.28% 8 6.83 5
4/21/2017 1.00 2318 2179 15 16,28 61% 7.6% 24.31% 8 6.91 5
4/22/2017 . a 2144 15 16,28 24% 0.0% 0.00% 8 3
4/23/2017 15 16,28 31% 0.7% 27.78% 8 7

15 16,28 57%

4/25/2017 15 16,26,28 26%

4/26/2017 15 16,26,28 7%

4/27/2017 15 16,26,28 60%

4/28/2017 15 16,26,28 60%

5/14/2017 ] 1.24 2187 2098 | 915 | 162672834 32% 0.3% 0.0% 9 721 2

5/15/2017 | 1,00 207 2084 | 915 | 162672834 66% 0.3% 0.0% 8 6.63 3

5/16/2017 | 1.00 2186 18 | 915 | 16262334 [N 0.0% 8 6.82 6

5/17/2017 | 1.00 215 2080 | 915 | 16262834 68% 4.2% 0.0% 10 6.68 3

5/18/2017 | 1.05 2159 2110 | 915 | 16262534 [N 4.2% 0.0% 7 6.98 5

5/19/2017 | 1.00 2199 231 | 915 | 162672834 63% 3.1% 0.0% 9 6.86 2

5/20/2017 | 1.00 2206 1993 | 915 | 16262834 0% 0.0% 0.0% e 6.52 5

5/21/2017 915 | 16262834 0% 0.0% 0.0% 9 6.99 2

5/22/2017 | 1. 9,15,27 | 16,26,28,34 0% 0.0% 0.0% 8 6.34 4

5/23/2017 915 | 16262834 64% 9.0% 0.0% 9 7.25 5

5/24/2017 915 | 16,26,2834 66% 4.9% 0.0% 9 6.70 4

5/25/2017 9 | 16262834 56% 0.3% 0.3% 8 7.25

5/26/2017 9 | 16262834 60% 3.8% 0.7% 3 7.21
5/27/2017 | (141 | 9 | 16262834 19% 1.7% 0.0% 3 4




S| Data Using Daily Cumulative Results

Chemical Addition

Slag Index Data

Combined Daily Operational Zone 2 Zone 3 Zone 2 Zone 3 Calcium Carbonate
Index (Green=0, (Left (Right | Cumulative Slag | Cumulative Slag Magnesium Hydroxide Dose | Dose rate (Lbs/Ton of
Yellow=1,Red=2) Date Side) Side) Build-up Build-up rate (Lbs/Ton of Coal) Coal)

4 4/8/2017 -2 0 -2 0 0 0
6 4/9/2017 -2 3 -4 3 0 0
1 4/10/2017 - 2 6 5 0 0
2 4/11/2017 -4 1 2 6 0 0
2 4/12/2017 4 -2 6 4 0 0
3 4/14/2017 6 12 15 0 0
2 4/15/2017 =il 1 14 0 0
5 4/16/2017 2 6 16 0 0
5 4/17/2017 5 13 21 0 0
5 4/18/2017 0 23 21 0 0
7 4/19/2017 0 41 21 0 0
5 4/20/2017 5 5] 46 24 0 0
5 4/21/2017 2 6 48 30 0 0
3 4/22/2017 -5 0 43 30 0 0
7 4/23/2017 5 5 48 35 0 0
4/24/2017 4 0 52 35 0 0

4/25/2017 2 7 54 42 0 0

4/26/2017 0 0 54 42 0 0

4/27/2017 2 5 56 47 0 0

4/28/2017 -5 -4 51 43 0 0

2 5/14/2017 -2 10 -2 1.2 1.2
3 5/15/2017 8 4 6 0.9 0.9
6 5/16/2017 -10 22 -4 0.9 0.9
3 5/17/2017 -11 11 12 1.2 1.2
5 5/18/2017 6 -3 17 9 1.2 1.2
2 5/19/2017 -11 0 6 9 1.5 1.5
5 5/20/2017 -2 0 4 9 2.0 2.0
2 5/21/2017 0 0 4 9 2.0 1.2
4 5/22/2017 0 0 4 9 2.0 1.2
5 5/23/2017 2 0 2 9 2.0 1.0
4 5/24/2017 2 8 4 12 2.0 1.0
5/25/2017 -2 ) 2 17 2.0 1.0

5/26/2017 H 4 2 21 2.0 1.0

5/27/2017 =5 -11 9 10 2.0 1.0

4/8/17

4/21/17

4/28/17

5/14/17

5/27/17
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Chemical Trial Results

Cumulative Slag Build-up without chemicals in April, with chemicals in May

60

50
:z /\//_‘,\ SChedUIQd =#=—"Zone 2 Cumulative Slag Build-up

20 [aY |t =#—Zone 3 Cumulative Slag Build-up

PYe
/ \ Zone 2 Cumulative Slag Build-up
10 —7‘&« A

==3é=Zone 3 Cumulative Slag Build-up

Front IR Camera

T T T > & T ]
1165/2017 4/15/2017 4/25/2017 5/5/2017 5/15/2&]9 5/25/2017 6/4/2017

Slag Index Value from Right-

Date

» The fundamental difference with chemicals was that the ash build-up increased & decreased
about the same throughout the 15 days

* During the non-chemical addition trial, the daily cumulative increase/decrease was skewed
much more to the increasing slag, resulting in an overall increase.

» The camera Sl data is providing operations information that can be used every shift. They
provide engineering data that is used to make decisions on operational changes which lead to
improved operations and reliability.
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Benefits of IR Cameras as an Operations Tool

«  This new instrument quantifies the,
*  Sootblower effectiveness
«  Dalily increase/decrease of ash (using the daily average of 4300+ Sl values)

«  The connection between particular coal blend and the slag changes
throughout a day

«  Correlation to HVT testing for localized reducing atmosphere’s resulting in
localized slagging

«  Effectiveness/Ineffectiveness of slag mitigation chemicals

«  Slag Index values can be connected to DCS with alarm settings for ash
increase ramp rate and absolute value
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IR Camera Difficulties — Most Recent Experiences

= Severe WW slagging results in interference with camera visual &
data collection capability. In-rushing cool ambient air through the
viewport tends to freeze the molten slag on the inside of the WW.

U1_LC_10-9-2017.avi.mp4

= One option to minimize the cold air influx would be a closure plate with a
spring loaded lens collar to seal the viewport opening with the door

opened.
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* The purpose of these cameras is not to use them as a “rear view mirror” pretty picture
that eliminates the need for an Operator to walk down the boiler.

= As Slag Index values change, it signals the Unit Operator to take action.

= We can’'t remove the ash that’s in coal, so slagging/ash build-up is something that
needs to be managed. IR cameras with Sl software provide operations another tool for
this management.

= We would also like to use the IR camera outputs as feedback to the VISTA software in
Fuels evaluations.
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Next Steps

Correlations

Advanced Metrics



Slag Index: 2 Day Snapshot

3
7t

Decreasing Peak/Valley Separation
shows increasing Tenacity
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Slag Index: 2 Day Snapshot

Increasing Period to Period Sl Level
Indicates Deposit Growth
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Alerts of Problematic Events

» Problematic Events
» RGE (Rapid Growth Event)
» Cycle Growth Strength >> 0

» Decrease of Cleaning Effectiveness Over
Multiple Cycles

» Slag Tenacity
» Maintenance Prediction

» Impact of Fuel Switching on Slag Cycle
» Impact of Mills on Cycle Types and Strengths
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Data Flow 3: Networking

Fleet Analytics
VAN

Input from Many Other Processes

Archive  Computer Controllers (DCS)

L i

Interpretive Software
Mid-IR Sensors . Actuator

The Process
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Outline

» Boiler Interiors: Slagging and Pollutant
Formation

» Mid-IR Imaging and Slag Index

» Slag Index at Duke Energy

» Temperature and Acoustic Pyrometry
» Flow of Data and Information
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Gas Temperature Measurements

» Key to Physical and Chemical Processes
» Heat Transfer
» Chemical Kinetics

» Key to Slag Formation (Ash Fusion)
» Key to Pollutant Formation (e.g., Thermal NO, & SO,)
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Acoustic Pyrometry

Sound Speed Related to Temperature: ¢ = yRT
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Information from Temperature Data

» Flatness of Temperature Distribution
» Hot Spot Location

» Fireball Location

» Surface Impingements
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Powerful Sound Generator

» Loud Sharp Sound Sources
» Using Plant Air Only; Safe and Reliable
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AP Start-Up/Operating Data




Installation Example: Ninghai
» Large Boiler Servicing Shanghai (1,000 MW)

50 Systems Installed in China
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Potential Benefits (from Users)

» AP for Startup Assistance

» Temp Control

» Header Temperature Differential/Stress

» Startup Coal Fineness Affects Mill Loadings
» Combustion

» Fireball Position

» Flame Impingement

» Mill Fineness Impact

» HP/Ton + CO + Pipe Velocity

» Oxygen Balancing
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Potential Benefits (Cont’d)

» Low Load NOx Control

» Gas Cofiring Feedback for Fuel Balancing

» Intelligent Sootblowing

» Lower Furnace Heat Transfer

» Atemperating Spray/Reheat Wall Coordination
» SNCR Control

» Online Deslagging
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Outline

» Boiler Interiors: Slagging and Pollutant Formation
» Mid-IR Imaging and Slag Index
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» Temperature and Acoustic Pyrometry
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Data Flow 1: Direct Video to Operator

Models Archive Computer Controllers (DCS)

Mid-IR Sensors ‘ Actuator

The Process
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Data Flow 2: Interpretive Software to DCS

Models Archive Computer Controllers (DCS)

Slat Index

Interpretive Software
Mid-IR Sensors ‘ Actuator

The Process
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Data Flow 3: Fleet Analytics

Fleet Analytics

Input from Many Other Processes

Archive ~ Computer Controllers (DCS)

i i

Interpretive Software
Mid-IR Sensors A Actuator

The Process

Enabled by Networking
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Next Steps

» Phenomena Not Captured by Slag Index
» Flame Impingement
» Slagging Outside “Boxes”
» “Dustiness” of Image
» Sootblower Behavior
» Combining Slag Indexing and AP Data
» Lower Furnace Temperatures to Control Slagging
» Demonstration Project
» Next Step
» Learning Software
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Data Flow 4: Deep Learning

ol

Cloud
Computing

Edge
Computing

Learning Fleet Analytics

Input from Many Other Processes

Learning Controls

Mid-IR and AP Sensors A Actuator

The Process

Learning Software: Neural Nets
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Questions?
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Special Thanks to:

» Duke Energy
» Stephen Storm
» Technical Staff at East Bend Generating Station

» Cal Lockert
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